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1. トルク解析について 

ここでは、今回行うトルク解析の考え方について説明を行う。 

 

図 1 に示す赤面と黒点を一体化させ、黒点に Z 軸周りのモーメントを加えることで、部材

にトルクを作用させる。 

 

図 1 トルク解析 
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2. モデル作成 

 今回解析するモデルは、図 2に示す、100×100×500 (mm) のモデルとする。 

 

 

図 2 解析モデル 
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初めに、以下に赤丸で示す部分を選択して[Geometry]モードに変更する。 

 

図 3 Geometryモード 

 

モデルの作成 

[New Entity] > [Primitives] > [Box]を選択する。 

表示されたウィンドウ内[Dimensions At Origin]の[Dx],[Dy],[Dz]で寸法を入力する。 

今回は 100×100×500mm なので、[Dx]には 0.1(m)、[Dy]には 0.1(m)、[Dz]には 0.5(m)

を入力し、[Apply and Close]を選択する。[Box_1] (参照：図 4) 

 

 

図 4 Box Construction 

 

 

 



4 

 

グループの作成 

グループは、図 5に青色で示す面を固定面 [fix] 、赤色で示す面を荷重面 [load]とする。 

 

図 5 グループ 

 

[New Entity] > [Group] > [Create] を選択する。 

[Shape Type]でグループのタイプを選択する。今回は面を指定するので、左から 3 番目の

の    (面)にチェックを入れる。 

[Group Name]より[Name]欄にグループ名を入力する。今回は[fix]と入力する。 

[Main Shape And Sub-Shapes]より[Main Shape]でグループを作成するモデルを選択する。

今回は[Box_1]を選択する。 

 

次にグループを指定する麺を選択する。モデルが表示されている画面で図 5 に青色で示し

た面を選択する。選択した面の輪郭が白くなったら、ウィンドウ右下の[Add]をクリックす

る。すると、隣の白い欄に選択した面を表す数字が表示される。 

※今回は[31]と表示された。 

また、選択しずらい場合には、キーボード[Ctrl]キーを押した状態で、マウスの右ボタンを

ドラッグすることで、表示角度を自由に動かすことが出来る。 
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最後に[Apply and Close]をクリックする。 

これで[Object Browser]の[Box_1]の下に[fix]グループが作成された。[fix] 

(参照：図 6左) 

 

[load]グループについても同様に作成する。[load] (参照：図 6右) 

※今回は[33]と表示された。 

 

 

図 6 グループ作成 

 

 

これで、モデルの作成が完了した。 
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3. メッシュ作成 

初めに、以下に赤丸で示す部分を選択して[Mesh]モードに変更する。 

 

図 7 Meshモード 

 

[Mesh] > [Create Mesh] を選択する。 

表示されたウィンドウ内[Geometry]に[Object Browser]から[Box_1]を選択する。 

次にウィンドウ下部の[Assign a set of hypotheses]をクリックし、 

[3D: Automatic Tetrahedralization]を選択する。 

選択すると、[Hypothesis Construction]という小さなウィンドウが表示されるので、これ

は[Cancel]を選択して閉じる。ここまでで図 8左の状態になっている。(参照：図 8左) 

 

次にウィンドウ内のタブを[1D]に変更する。[Hypothesis]欄右の歯車の様なボタンをクリッ

クし、[Local Length]を選択する。 

選択すると、[Hypothesis Construction]という小さなウィンドウが表示される。このウィ

ンドウ内の[Length]で、メッシュ長さを設定する。今回はメッシュ長さを 0.02ｍとするの

で、[Length]の欄に 0.02(m)と入力し、[OK]を選択する。(参照：図 8右) 

 

 

図 8 メッシュ設定 

 

ここで元のメッシュウィンドウに戻るので[Apply and Close]を選択する。[Mesh_1] 
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[Object Browser]内に先程作成した[Mesh_1]が表示されるので、[Mesh_1]を選択し、右ク

リックをして[Compute]を選択する。 

 

メッシュ作成が完了すると、[Mesh computation succeed]というウィンドウが表示される。

ここでメッシュの要素数等を確認することが出来る。(参照：図 9) 

 

 

図 9 メッシュ作成 

 

 

これで、メッシュの作成が完了した。 
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荷重点の作成① 

モーメントを作用させる点を作成する。 

 

[Modification] > [Add] > [Node]を選択する。 

表示されたウィンドウ内[Coordinates]に、作成する点の座標を入力する。 

今回は[X]に 0.05(m)、[Y]に 0.05(m)、[Z]に 0.6(m)を入力し、[Object Browser]内[Mesh_1]

を選択した状態で[Apply and Close]をクリックする。(参照：図 10) 

 

図 10 Add Node 

 

 

[Modification] > [Add] > [0D Element]を選択する。 

表示されたウィンドウ内[Add 0D Element]の[Id Nodes]に、先程作成した点を選択し、

[Apply and Close]を選択する。 

今回は[1051]と表示された。(参照：図 11) 

 

 

図 11 Add 0D Element 
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次に、[Object Browser]内の[Mesh_1]を選択した状態にして、モデルが表示されている画

面で右クリックをし、[Display Entity] > [0D Elements]を選択する。(参照：図 12) 

これで、先程作成した 0Dの要素が表示される。 

 

 

図 12 Display 0D Elements 

 

 

荷重点の作成② 

上記の方法で点の作成できなかった場合は、以下の方法で作成する。 

 

まず、[Object Browser]内の[Mesh_1]を選択した状態で、モデルが表示されている画面で

右クリックをし、[Numbering] > [Display Nodes #]を選択する。(参照：図 13左) 

  

図 13 Numbering Nodes 
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すると、各点に番号が表示される。(参照：図 13右) 

 

[Modification] > [Add] > [Node]を選択する。 

表示されたウィンドウ内[Coordinates]に、作成する点の座標を入力する。 

今回は[X]に 0.05(m)、[Y]に 0.05(m)、[Z]に 0.6(m)を入力し、[Object Browser]内[Mesh_1]

を選択した状態で[Apply and Close]をクリックする。(参照：図 14左) 

すると、モデルが表示されている画面に[1051]という点番号が表示される。(参照：図 14右) 

 

 

図 14 Add Node 

 

 

[Modification] > [Add] > [0D Element]を選択する。 

表示されたウィンドウ内[Add 0D Element]の[Id Nodes]に、先程表示された点番号を入力

し、[Object Browser]内の[Mesh_1]を選択した状態で[Apply and Close]をクリックする。 

 (参照：図 15) 

 

 

図 15 Add 0D Element 
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次に、[Object Browser]内の[Mesh_1]を選択した状態で、モデルが表示されている画面で

右クリックをし、[Display Entity] > [0D Elements]を選択する。(参照：図 16) 

これで、先程作成した 0Dの要素が表示される。 

 

 

図 16 Display 0D Elements 

 

 

グループの作成 

次にグループの作成を行う。 

 

[Object Browser]内[Mesh_1]を右クリックし、[Create Group]を選択する。 

表示されたウィンドウ内の[Elements Type]は左端の[Node]にチェックを入れる。 

 

[Group type]は[Group on geometry]にチェックを入れる。ここにチェックを入れると、

[Geometry]モードで作成したグループを参照することが出来る。 

[Geometrical Object]右の矢印ボタンをクリックし、[Direct geometry selection]を選択する。 

次に[Object Browser]内で[Geometry] > [Box_1] > [load]と展開し、[load]グループを選択す

る。グループ作成ウィンドウで[load]グループが参照されたことを確認し、[Apply]を選択

する。(参照：図 17左) 

 

同様に、[fix]グループも作成する。[fix]グループの場合は、[Elements Type]を左から 3番

目の[Face]にチェックを入れる。(参照：図 17右) 

[Apply]を選択する。 
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図 17 グループ作成 

 

次に、モーメントを作用させる点のグループを作成する。 

[Elements Type]を左端[Node]に変更し、[Group type]は[Standalone group]に変更する。 

[Name]欄にはグループ名を入力する。今回は[Moment]とする。 

 

モデルが表示されている画面から荷重点を選択し、[Add]をクリックする。今回は左欄に

[1051]と表示された。(参照：図 18) 

その後、[Apply] をクリックし、[Close]でウィンドウを閉じる。 

 ※[Apply and Close]で閉じても良いが、[Object Browser]内にグループが反映されない場

合があるので、[Apply] > [Close]と分けて行うと確実に反映される。 

 

次に、先程作成した[load]グループに荷重点を追加する。 

[Object Browser]内より、[Mesh_1] > [Groups of Nodes]を展開する。表示された[load]を

右クリックし、[Edit Group as Standalone]を選択する。(参照：図 18) 

 

 

図 18 グループ編集 

 

表示されたウィンドウ内 [Select From]より [Group]の欄にチェックを入れ、 [Object 

Browser]内の[Moment]グループを選択する。[Content]欄の右にある[Add]をクリックし、

[id Elements]に[1051]が追加されたことを確認して[Apply and Close]をクリックする。 



13 

 

(参照：図 19) 

 

図 19 Edit Group 

 

ここで、[Mesh]モードで作成したグループの確認を行う。 

[Object Browser]内、[Mesh_1] > [Groups of Nodes] > [load]で右クリックをし、[Show 

Only]を選択する。図 20左のように表示されているか確認する。(参照：図 20左) 

  

図 20 loadグループ 
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点が表示されない場合は、モデルが表示される画面内で右クリックをし、 

[Numbering] > [Display Nodes #]を選択する。図 20左のように表示されているか確認する。 

(参照：図 20左) 

 

次に[Moment]グループの確認も、[load]グループと同様に行う。(参照：図 21) 

  

図 21 Momentグループ 

 

最後に[fix]グループの確認を行う。(参照：図 22) 

 

図 22 fixグループ 

 

 

 

これで、グループの作成が完了した。 
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4. 解析 

初めに、以下に赤丸で示す部分を選択して[Aster]モードに変更する。 

 

図 23 Asterモード 

 

解析コードの作成 

初めに、ウィザードを用いて解析コードの作成を行う。 

[Aster] > [Wizards] > [Linear elastic]を選択する。 

 

表示されたウィンドウで[What kind of model do you want to work on? ]と聞かれるので、

デフォルトの[3D]のままで[Next > ]を選択する。 

 

次に[Select a mesh from the Salome object browser]と言われるので、[Object Browser]よ

り、解析に用いるメッシュを選択する。ここでは[Mesh_1]を選択する。 

下に表示されている[Use mesh groups]/[Use geometrical groups]では、どちらで作成した

グループを使用するのかを聞いているので、今回は[Use mesh groups]にチェックを入れ、

[Next > ]を選択する。 

 

次に[Young’s modulus and Poisson ratio definitions]と言われる。ここではヤング率(E)と

ポアソン比(ν)を聞かれているので、解析を行うモデルの材料のヤング率とポアソン比を入

力する。今回は材質を[Steel]とするので、ヤング率(E)に 2.1e11(N/m2)、ポアソン比(ν)に

0.3を入力して、[Next >]を選択する。 

 

次に[Adding imposed degrees of freedom on groups]と言われるが、ここは後に編集を行う

ので、そのまま[Next >]を選択する。次の[Adding pressure on meshes groups]も同様にそ

のまま[Next >]を選択する。 

 

最後にコマンドファイルを保存する場所を聞かれるので、[Aster command file]欄右のボタ

ンから任意の場所に保存(今回は[2.comm]という名前で保存)し、[Finish]を選択する。

[linear-static] 
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解析コードの編集 

ウィザードが終了すると、Code_Asterの解析コードが出来るので、その編集を行っていく。 

 

[Object Browser]内にある[Aster]という文字の左にある＋マークをクリックして、 

[Aster] > [linear-static] > [Data] と展開する。 

 [Data]下に[2.comm](先程作成したコマンドファイルの名前)が表示されているので、これ

を右クリックし、[Run Eficas]を選択する。(参照：図 24) 

 

 

図 24 Run Eficas 

 

[Choix d’une version du code Aster]というウィンドウが表示される場合があるので、これ

が表示された場合は[OK]を選択する。 
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[Eficas]というウィンドウが表示される。(参照：図 25) 

このウィンドウで解析コードの編集を行っていく。 

 

図 25 Eficas 

 

今回はトルク解析なので、 

 ■ CREA_MAILLAGE  ： メッシュの設定 

 ■ AFFE_MODELE  ： モデルの設定 

 ■ AFFE_CHAR_MECA ： 境界条件の設定 

 ■ AFFE_CARA_ELEM ： 要素の設定 

 ■ MECA_STATIQUE  ： 解析の Solver設定 

の項目について編集を行う。 
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■ CREA_MAILLAGEの編集 

まず、[■ MODE_MAILLAGE]を選択し、ウィンドウ右側のタブを[Nouvelle Commande]

に変更する。表示された項目の中から[CREA MAILLAGE]を探し、ダブルクリックをする。 

すると、[■ MODE_MAILLAGE]の下に[■ CREA_MAILLAGE]の項目が追加されるので、

この項目について編集を行う。[■ MODE_MAILLAGE]は今回必要ないので右クリックを

し、[Supprimer]を選択して削除する。 

 

[■ CREA_MAILLAGE]の項目を以下の状態になるよう編集を行う。 

 

 ■ CREA_MAILLAGE : mesh 

   ● MAILLAGE :  MAIL 

   ◆ CREA_POI1 : 

    ● GROUP_NO :  (Moment) 

 

初めに、[■ CREA_MAILLAGE]を選択し、右側[Mots Clefs Permis]欄に表示された項目

の中から[MAILLAGE]を探し、ダブルクリックする。[Commande]欄に[● MAILLAGE]

が表示されるのでそれを選択し、右側欄に表示されている[MAIL]をダブルクリックする。 

 

次に、[■ CREA_MAILLAGE]を選択し、右側[Mots Clefs Permis]欄に表示された項目の

中から[CREA_POI1]を探し、ダブルクリックをする。 

[Commande]欄に[◆  CREA_POI1]が表示されるのでそれを選択し、右側[Mots Clefs 

Permis]欄の項目の中から[GROUP_NO]を探し、ダブルクリックする。 

 

[Commande]欄に[● GROUP_NO]が表示されるのでそれを選択し、右側[Valeur]欄にモー

メントを作用させる点のグループを入力する。今回は[Moment]を入力する。 

入力をしたら、入力欄左にある左向き矢印のボタンをクリックし、ウィンドウ下部にある

[Valider]をクリックする。 

 

最後に、[■ CREA_MAILLAGE]を選択し、ウィンドウ右側のタブを[Nommer Concept]

に変更する。表示された[Nom du concept]の欄に適当な名前を付け、ウィンドウ下部の

[Valider]をクリックする。今回は名前を[mesh]とした。 

[■ CREA_MAILLAGE]の[■]が[■]に変更されたことを確認する。 
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■ AFFE_MODELEの編集 

[■ AFFE_MODELE]の項目を以下の状態になるよう編集を行う。 

 

 ■ AFFE_MODELE :   MODE 

   ● MAILLAGE :    MAIL 

   ◆ AFFE : 

    ◆ AFFE_1 : 

      ● TOUT :   OUI 

      ● PHENOMENE :  MECANIQUE 

      ◆ b_mecanique 

       ● MODELISATION :  3D 

    ◆ AFFE_2 : 

      ● GROUP_NO :  (Moment) 

      ● PHENOMENE :  MECANIQUE 

      ◆ b_mecanique 

       ● MODELISATION : (DIS_TR) 

 

初めに、[■ AFFE_MODELE]を選択し、右側[Mots Clefs Permis]の欄に表示された項目

の中から[AFFE]を探し、ダブルクリックをする。[Commande]欄に[◆ AFFE_2]が表示さ

れるので、それを選択する。[◆ AFFE_2]の下に[● PHENOMENE]と表示されるのでそ

れを選択し、右側の欄に表示された項目の中から[MECANIQUE]を探し、ダブルクリック

する。 

[● PHENOMENE]の下に[◆ b_mecanique]が追加されるのでそれを選択し、その下に表

示された[● MODELISAION]を選択する。右側に表示された[Valeur(s) possibles(s)]の項

目の中から [DIS_TR]を探し、ダブルクリックをする。 [Valeur(s) actuelle(s)]の欄に

[DIS_TR]が表示されたのを確認して、ウィンドウ下部の[Valider]をクリックする。 

 

次に[◆ AFFE_2]を選択し、右側[Mots Clefs Permis]の欄に表示された項目の中から

[GROUP_NO]をダブルクリックする。[◆ AFFE_2]の下に[● GROUP_NO]が表示される

のでそれを選択し、右側[Valeur]欄に [Moment]を入力する。 

入力をしたら、入力欄左にある左向き矢印のボタンをクリックし、ウィンドウ下部にある

[Valider]をクリックする。 

[■ AFFE_MODELE]の[■]が[■]に変更されたことを確認する。 

 

この部分で、[Moment]グループに回転と平行移動の機能を付け足す設定を行った。 
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■ AFFE_CHAR_MECA の編集 

[■ AFFE_CHAR_MECA]の項目を以下の状態になるよう編集を行う。 

 

 ■ AFFE_CHAR_MECA :  CHAR 

   ● MODELE :     MODE 

   ◆ DDL_IMPO :   

    ● GROUP_NO :   (fix) 

    ● DX :     0.0 

    ● DY :    0.0 

    ● DZ :    0.0 

   ◆ LIAISON_SOLIDE : 

    ● GROUP_NO :   (load) 

   ◆ FORCE_NODALE : 

    ● GROUP_NO :   (Moment) 

    ● MZ :     1000 

 

 

まず、[■ AFFE_CHAR_MECA] > [◆ DDL_IMPO]と展開する。 

この状態では[● GROUP_NO]に[load]グループが設定されているので、これを[fix]グルー

プに変更する。[● GROUP_NO]を選択し、右側[Valeur(s) actuelle(s)]の中から[load]を選

択する。[Valeur]の文字の下に 2つ矢印のボタンがあるので、そのうち下側の右向きの矢印

ボタンをクリックする。すると、[Valeur]の欄に[load]という文字が表示されるので、ここ

を[fix]に変更し、左向きの矢印ボタンをクリックする。[Valeur(s) actuelle(s)]の欄に[fix]と

表示されたことを確認し、ウィンドウ下部の[Valider]をクリックする。 

この部分で、[fix]グループの変位を 0とする設定を行った。 

 

次に、[■ AFFE_CHAR_MECA]を選択し、右側[Mots Clefs Permis]の欄に表示された項

目の中から[LIAISON_SOLIDE]を探してダブルクリックをする。 

[Commande]欄に[◆ LIAISON_SOLIDE]が表示されるのでそれを選択し、右側[Mots 

Clefs Permis]の欄から[GROUP_NO]を探してダブルクリックをする。追加された [◆ 

GROUP_NO]を選択し、右側[Valeur]欄に [load]を入力する。入力をしたら、入力欄左に

ある左向き矢印のボタンをクリックし、ウィンドウ下部にある[Valider]をクリックする。 

この部分で、[load]グループが一体となって動くよう設定を行った。 
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次に、[■ AFFE_CHAR_MECA]を選択し、右側[Mots Clefs Permis]の欄に表示された項

目の中から[FORCE_NODALE]を探してダブルクリックをする。 

[Commande]欄に[◆ FORCE_NODALE]が表示されるのでそれを選択し、右側[Mots Clefs 

Permis]の欄から [GROUP_NO]を探してダブルクリックをする。追加された [◆ 

GROUP_NO]を選択し、右側[Valeur]欄に [Moment]を入力する。入力をしたら、入力欄左

にある左向き矢印のボタンをクリックし、ウィンドウ下部にある[Valider]をクリックする。 

次に[◆ FORCE_NODALE]を選択し、右側[Mots Clefs Permis]の欄から[MZ]を探してダ

ブルクリックをする。[● GROUP_NO]の下に[● MZ]が表示されるのでそれを選択し、右

側の[Valeur]欄に Z軸周りのモーメントを入力する。今回は 1000 (Nm)とするので、[Valeur]

欄に[1000]と入力し、ウィンドウ下部の[Valider]を選択する。 

この部分で、[Moment]グループに Z軸周りのモーメント 1000(Nm)を作用させる設定を行

った。 

[■ AFFE_CHAR_MECA]の[■]が[■]に変更されたことを確認する。 

 

最後に[◆ PRES_REP]を選択し、右クリック > [Supprimer]を選択して削除する。 

 

 

■ AFFE_CARA_ELEM の編集 

まず、[■ AFFE_CHAR_MECA]を選択し、ウィンドウ右側のタブを[Nouvelle Commande]

に変更する。表示された項目の中から[AFFE_CARA_ELEM]を探し、ダブルクリックをす

る。すると、[■ AFFE_CHAR_MECA]の下に[■ AFFE_CARA_ELEM]の項目が追加され

るので、この項目について編集を行う。 

 

 ■ AFFE_CARA_ELEM :  cara 

   ● MODELE :    MODE 

   ◆ DISCRET 

    ◆ b_SYME_OUI 

      ● CARA :     K_TR_D_N 

      ◆ b_AK_TR_D_N :   

       ● GROUP_NO :   (Moment) 

       ● VALE :   (1,1,1,1,1,1) 

 

 

初めに、[■ AFFE_CARA_ELEM]下の[● MODELE]を選択し、右側の欄に表示された

[MODE]をダブルクリックする。 
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次に[■ AFFE_CARA_ELEM]を選択し、右側[Mots Clefs Permis]の欄に表示された項目

の中から[DISCRET]を探し、ダブルクリックをする。[Commande]欄に[◆ b_SYME_OUI]

が表示されるので、それを選択する。[◆ b_SYME_OUI]の下に[● CARA]と表示されるの

でそれを選択し、右側の欄に表示された項目の中から[K_TR_D_N]を探し、ダブルクリック

する。すると[● CARA]の下に[◆ b_AK_TR_D_N]が表示されるのでそれを選択し、右側

[Mots Clefs Permis]に表示された項目から[GROUP_NO]を探してダブルクリックする。 

追加された[● GROUP_NO]を選択し、右側[Valeur]欄に [Moment]を入力する。 

 

※上記の[● CARA]で選択した[K_TR_D_N]はそれぞれ、[K：剛性マトリックス]、 

[TR：平行移動と回転]、[D：対角行列]、[N：点]を表している。 

次で設定する[VALE]では、剛性マトリックスの対角線上の値を定義する。 

この作業によって、ノードグループ[Moment]が荷重を与える時に使用されるだけで、 

それ以外には全く影響を与えないという設定にすることが出来る。 

 

次に[◆ b_AK_TR_D_N]を選択し、右側[Mots Clefs Permis]に表示される項目の中から

[VALE]を探してダブルクリックをする。追加された[● VALE]を選択し、右側の[Valeur]

欄に値を入力する。今回は（1,1,1,1,1,1）という値を入力する。 

 ※入力の仕方は、[Valeur]欄に 1入力 > エンター > 1入力 > エンター > 1入力 > エ

ンター > 1入力 > エンター > 1入力 > エンター > 1入力 > エンター > [Valider]

で操作する。 

 

最後に[■ AFFE_CARA_ELEM]を選択し、ウィンドウ右側のタブを[Nommer Concept]に

変更する。表示された[Nom du concept]の欄に適当な名前を付け、ウィンドウ下部の

[Valider]をクリックする。今回は名前を[cara]とした。 

[■ AFFE_CARA_ELEM]の[■]が[■]に変更されたことを確認する。 

 

 

 

 

 

 

 

 

 

 

 



23 

 

■ MECA_STATIQUE の編集 

[■ MECA_STATIQUE]の項目を以下の状態になるよう編集を行う。 

 

 ■ MECA_STATIQUE :   RESU 

   ● MODELE :   MODE 

   ● CHAM_MATER :  MATE 

   ● CARA_ELEM :    cara 

   ◆ EXCIT :     

    ● CHARGE :    CHAR 

 

初めに[■ MECA_STATIQUE]を選択し、右側[Mots Clefs Permis]欄に表示された項目の

中から[CARA_ELEM]を探してダブルクリックをする。 

追加された[● CARA_ELEM]を選択し、右側の欄から[cara]を選んでダブルクリックをす

る。 

[■ MECA_STATIQUE]の[■]が[■]に変更されたことを確認する。 

 

 

 

 

最後に、先程行った編集を保存する。 

[Fichier] > [Enregistrer]で上書き保存が出来る。 

名前を付けて保存をしたい場合は[Fichier] > [Enregistrer sous]で行うことが出来る。 

 

保存が完了したら、[Fichier] > [Quitter]でウィンドウを閉じる。 

 

 

これで解析コードの編集が完了した。 

 

 

実行 

[Object Browser]内より、[linear-static]を右クリックし[Run]を選択する。 

しばらくすると解析が始まり、[Bash]が表示される。 

解析が問題なく終了すると、[Object Browser]内に[Post-Pro]の項が表示される。 
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5. 結果表示 

初めに、以下に赤丸で示す部分を選択して[Post-Pro]モードに変更する。 

 

図 26 Post-Proモード 

 

変位量の表示 

[Object Browser]内より、 

[Post-Pro] > [*linear-static.rmed] > [MAIL] > [Fields] > [RESU__DEPL,-]を展開する。 

下に[0, -]があるので、これを右クリックし[Deformed Shape and Scalar Map]を選択する。 

 

[Deformed Shape and Scalar Map]というウィンドウが表示される。(参照：図 27) 

ここでは表示される変形の倍率などを変更することが出来るので、何も変更がない場合に

は[OK]をクリックする。[ScalarDef.Shape] 

 

図 27 Deformed Shape and Scalar Map 

 

 

これで変形図の可視化が出来る。(参照：図 28) 
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 図 28 変形図 
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応力度分布図の表示 

[Object Browser]内より、 

[Post-Pro] > [*linear-static.rmed] > [MAIL] > [Fields] > [RESU__SIEQ_NOEU]を展開。 

下に[0, -]が表示されるので、これを右クリックし[Scalar Map]を選択する。 

 

[Scalar Bar Properties]というウィンドウが表示されるので[OK]を選択する。[ScalarMap] 

 

[Object Browser]内に新しく表示された[ScalarMap]を右クリックし、[Show Only]を選択

する。これで応力度分布図が表示される。(参照：図 39) 

 

 

 

図 39 応力度 

 

 

 


